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Que Fait CityDesk ? 
CityDeskTM est le moyen le plus facile pour gérer des sites Web qui changent souvent. 

Que ce soit pour créer un quotidien avec des centaines de journalistes ou une lettre 
d'information mensuelle, CityDesk apporte à chacun la puissance des outils de "Web content 
management" (gestion de contenus Web). 

Avec CityDesk, les gens qui ne connaissent rien au HTML ou aux serveurs Web peuvent 
facilement ajouter, éditer et retirer les articles d'un site Web, en utilisant un programme qui 
est aussi facile qu'un traitement de texte. CityDesk appliquera automatiquement une mise en 
forme standard, conformément aux masques que vous fournissez à ces articles. Puis  il les 
copie sur votre serveur Web automatiquement. Chaque article peut comprendre des images, 
des sons, et d'autres éléments médias. 

Voilà juste quelques exemples des choses que vous pouvez construire et gérer avec CityDesk . 

? Un journal quotidien, une newsletter mensuelle ou un magazine sur le web  
? Un journal personnel ou un weblog 
? Une liste des emplois à pourvoir pour une société  
? Un magazine d'annonces immobilières listant les propriétés restant disponibles à la 

vente.   
? Une base de connaissances pour une société  

La vraie puissance de CityDesk vient du fait que vous ne concevez le design de votre site 
qu'une fois. Après cela, il est facile de créer de nouveaux articles qui utilisent le même design. 
Parce que CityDesk conserve le texte des articles dans un endroit séparé du design, vous 
pouvez changer le design d'un côté, et chaque article sur votre site sera modifié en 
conséquence.   

Une fois votre site réglé, le mettre à jour est aussi facile qu’utiliser un traitement de texte sur 
Windows. Le traitement de texte intégré est WYSIWYG (« What You See Is What You Get ») 
et comprend un vérificateur de mots en anglais, un compteur de mots, une fonction chercher 
et remplacer et des commandes de mise  en page. 



Turoriel CityDesk 

CityDesk est une marque déposée de Fog Creek Software, Inc. 
©2001 Fog Creek Software, Inc All Rights Reserved – Traduction française elanceur 

 

CityDesk est construit sur un moteur de base de données puissant et robuste. Cela veut dire 
que différentes personnes peuvent mettre à jour le site simultanément sans aucun risque de 
conflit ou d'altération. Vous pouvez même avoir toute une salle de rédacteurs tapant tous au 
clavier en même temps ; même une salle de rédaction virtuelle, avec des contributeurs tous 
sur l'Internet ! 

Si vous avez besoin de gérer un site avec plusieurs versions différentes, CityDesk est 
inestimable. Supposons  que vous vouliez publier une newsletter chaque semaine en deux 
langues. CityDesk fournit une belle interface pour les traducteurs où ils peuvent voir une liste 
de tous les articles non traduits pour les traduire  à la volée dans un environnement à deux 
fenêtres. Si vous essayez de publier le site avant que tout n'ait été traduit, vous verrez un 
avertissement ! 

Ou supposons que vous produisiez une lettre d'information (newsletter) en plusieurs éditions 
régionales. La plupart des articles sont les mêmes, mais vous ne voulez pas faire tourner votre 
poème "Toute Personne Civilisé Adore Le PSG " dans l'édition de Marseille. CityDesk prend 
en considération votre désiderata et publie les deux éditions automatiquement. 

CityDesk peut aussi garder une trace de vos articles qui ont besoin de rester maintenus sous  
embargo jusqu'à une certaine date. Ecrivez simplement l'article et indiquez l'intervalle de 
publication : CityDesk ne publiera jamais l'article avant ou après ces dates. Un bon moyen de 
publier du contenu sur votre site Web quand vous êtes en vacances. 

Beaucoup de sites Web sont publiés en plusieurs formats. Par exemple, vous pourriez avoir : 

? la version Web normale  
? une version "impression" pour le Web sans publicité et sans icônes de navigations  
? une version pour les Palm Pilot sans images  
? une version "Grande Police de Caractère" que vous dédiez pour les gens qui aiment les 

polices de caractère plus grandes  
? une version imprimée que vous donnez en coin de rue aux passants (qui l'utilisent 

pour garnir les cages aux oiseaux, ces fripons !)  
? et ainsi de suite.  

Mettre en place les familles de masques pour chacune de ces versions est une opération 
"toute en un". Après cela, vous n'avez plus qu'à taper l'article une seule fois et il sera 
automatiquement publié dans chacun de ces formats sans travail supplémentaire. Tra la la ! 

Nous pensons que vous trouverez que CityDesk extrêmement puissant, et tout à fait facile à 
comprendre. Ce tutoriel vous emmènera en un éclair sur un auto-apprentissage d'environ 10 
minutes. Après cela, vous n'aurez plus qu'à regarder de temps en temps la documentation. 

Prêt(e) ? Partons ! 
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Leçon 1- Créer un Site Simple 

Dans CityDesk, chaque élément de votre site, -articles, fichiers HTML, masques de mises en 
page, images, et tout ce que vous voulez publier- est stocké dans un seul fichier sur votre 
disque dur. Quand vous créez un site, vous créez en fait un seul fichier. 

Démarrez CityDesk, s'il ne tourne pas déjà, en choisissant la commande "Démarrer" »Fog 
Creek SoftWare » CityDesk. 
 

  Sélectionnez File » New Site 

Si c'est la première fois que vous lancez CityDesk, vous verrez un message de bienvenue. 
Dans ce cas : 

  Cliquez sur Create a new CityDesk site 

Une boîte de dialogue vous demandera de nommer votre site et de le sauvegarder sur votre 
ordinateur. 

  Tapez un nom pour votre site et cliquez sur Save  

Comme vous pouvez le constater, vous avez maintenant créé un nouveau site avec quelques 
éléments dedans. 

? Il y a un dossier pour les articles nommé Articles qui contient déjà un article dedans, 
appelé Getting Started. 

? Il y a un dossier pour les images appelé Images qui contient déjà une image dedans. 
? Il y a un article appelé index. Quand il est publié, il deviendra la page index.html 

qui est la première chose que les gens voient quand ils visitent votre site Web.  

  Essayez de double-cliquer sur l'article Getting Started.  Vous pouvez l'éditer en utilisant 
le traitement de texte intégré. 

  Cliquez sur Save and Close. 
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Leçon 2 : Prévisualiser le Site 
La commande de Prévisualisation vous laisse regarder à quoi votre site ressemblera sans le 
publier sur un serveur Web. Elle publie une copie complète de votre site dans un répertoire 
temporaire sur votre disque dur. 

  Dans la fenêtre principale, cliquez sur l'icône Prévisualisation située dans la barre 
d'outils.             

Une fenêtre d'état vous indique la progression de la publication. CityDesk mixe le texte de 
tous vos articles sur votre site avec leurs mises en page respectives pour générer des pages 
complètes en code HTML. 

Quand c'est fini, un bouton apparaît vous signalant que vous pouvez prévisualiser votre site 
en utilisant Microsoft Internet Explorer. 

  Cliquez sur le bouton Internet Explorer. Regardez ce site simple avec seulement un 
article. 

  Fermez le navigateur Web et cliquez sur le bouton Close dans la fenêtre de Publication. 

Dans la prochaine leçon, nous ajouterons un nouvel article.
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Leçon 3 - Ajouter un Nouvel Article 

Créons un nouvel article 

  Dans la fenêtre principale, cliquez sur le dossier Articles. (Dans CityDesk, vous pouvez 
utiliser les dossiers comme vous voulez pour trier et organiser vos articles.) 

  Sélectionnez File » New » Article ou cliquez sur l'outil New Article  

Un nouvel article apparaîtra. A partir du dossier Articles que vous aurez sélectionné, dites 
vous que c'est là qu'il ira se ranger.  

  Saisissez un nom pour cet article et appuyez sur Enter. (sur la touche return ou entrée) 

  Double-cliquez sur l'article que vous venez de créer. Une fenêtre s'ouvrira et vous pouvez 
dès à présent commencer à saisir votre article. Ecrivez quelque chose de drôle sur les 
"anteaters" 

Le traitement de texte intégré de CityDesk vous laisse formater, vérifier l'orthographe (en 
anglais), créer des hyperliens, insérer des images et éditer tous les attributs de votre article. 

  Dans la fenêtre de l'article, cliquez sur l'onglet qui dit Properties 

Ici vous pouvez choisir des options qui affectent la mise en page de votre article. Par exemple, 
vous pouvez écrire un titre d'article ou choisir le masque de mise en page à utiliser. Vous 
pouvez aussi programmer la date de parution de votre article ou associer certains mots-clés 
avec l'article pour le rechercher plus tard. 

  Mettez un titre sur votre article. Tapez votre nom d'auteur dans la "boîte auteur"(author 
box). N'ayez pas peur ! 

  Dans la fenêtre article, cliquez sur l'onglet qui dit Extras. 

C'est là que vous écrivez les autres éléments de l'article comme le "teaser". (Un teaser est une 
courte introduction à l'article qui invite les gens à lire plus). L'apparition de ces éléments 
diffère selon le masque de mise en page que vous utilisez. 

  Remplissez le "Teaser" et la "Sidebar" 

  Cliquez sur  Save and Close. 

  Prévisualisez votre site à nouveau. Regardez comment votre nouvel article apparaît à 
l'écran par rapport à votre original.         
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Leçon 4 - Changer l'Apparence des Articles 

Vous pouvez modifier l'apparence de tous vos articles à un endroit en modifiant seulement le 
gabarit de mise en page. 

  Vérifiez que le Mode Designer est activé en sélectionnant  View » Designer Mode. 
Quand le Mode Designer est activé, une barre d'outils plus complète surgit dans le menu en 
haut. 

  Sélectionnez View » Templates ou cliquez sur l'outil de gabarit (Templates Tool) sur la 

barre d'outils.          

  Double-cliquez sur le gabarit appelé Simple (.html). 

Un "template" est un document HTML encapsulé contenant tous les éléments qui 
restent invariables pour chaque article qui l'utilise. Tout changement que vous ferez ici 
modifiera l'apparence de tous les articles utilisant ce template (gabarit de mise en page). 
Vous pouvez avoir autant de gabarits que vous voulez.  

Des changements plus sophistiqués peuvent être faits en cliquant sur l'onglet HTML 
View et en éditant directement le HTML. Vous pouvez aussi retoucher vous-même le gabarit 
en utilisant un éditeur HTML plus sophistiqué comme Macromedia Dreamweaver, Microsoft 
FrontPage, etc... Pour utiliser n'importe quel éditeur externe enregistré sur votre 
système, faites un clic-droit sur l'icône template dans la fenêtre Templates. 

Tout ce qui figure entre accolades {$ et  $} est un élément CityScript qui sera 
remplacé quand vous publierez votre site. CityScript est le langage de script intégré de 
CityDesk. Il est très facile à apprendre et vous n'avez même pas besoin d'être un 
programmeur. 

Par exemple, {$.headline$} sera remplacé par le titre de l'article de chacun des articles. 
(Le titre de l'article est accessible à partir de l'onglet Properties dans l'éditeur d'article). 
{$.body$}  est remplacé par le texte principal de l'article. 

Cityscript vous permet aussi de créer des variables. Les variables représentent des morceaux 
de texte qui peuvent être changées en un endroit, modifiant par la même l'ensemble du site. 
Par exemple, un nom de société pourrait apparaître sur chaque page du site, représenté par 
une variable. Dans le cas d'une fusion, rachat, ou si le nom de l'entreprise a tendance à être 
détestable en Basque, le nom de l'entreprise peut être changé seulement une fois dans la liste 
des variables et ce changement sera repris chaque fois que la variable apparaîtra sur le site. 
Dans ce gabarit simple de mise en page, nous utilisons deux variables : {$.SiteName 
$} et {$.TagLine $}. 

  Fermez la fenêtre "Simple Template" et la fenêtre "Templates". 
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Leçon 5 - Modifier la Page d'Accueil 

CityDesk vous laisse déposer par un glisser-déposer tout fichier que vous voulez à l’intérieur 
de votre site : 

? Fichiers HTML 
? Images 
? Autres fichiers texte 
? Autres fichiers binaires 

Ces fichiers peuvent être triés à l’intérieur de dossiers. L’arbre entier sera publié sur votre 
serveur Web.  

Votre site contient un tel fichier appelé index. Il est là parce que la plupart des serveurs Web 
cherchent un fichier intitulé  index.html pour l'afficher quand les visiteurs Web entrent 
sur le site. 

  Double-cliquez sur  index à partir de la fenêtre principale pour éditer la page d'accueil. 

Ceci ouvre la page d'accueil dans un traitement de texte intégré. Les articles peuvent contenir 
des CityScript tout comme les gabarits de mise en page. 

Qu'est-ce qui se passe sur ce fichier ? Jetons un coup d'oeil à la ligne CityScript. Suivez-bien :  

{$.SiteName$}  
Le point ici nous indique que SiteName est une variable. Quand cette page est publiée, 
CityDesk cherche une variable nommée SiteName et imprime sa valeur ici. 

{$.TagLine$} 
Une autre variable utilisant une fonte plus petite dans ce cas  

{$foreach x in (all)$} 
C'est le début d’une boucle. CityDesk répétera chaque fois entre l’énoncé foreach et l'énoncé 
next -  pour chaque article sur le site. 

{$ x.headline$} 
Cela extrait le titre de l'article. Remarquez que cela apparaît en bleu avec un souligné. Vous 
savez ce que cela signifie non ? Bien c'est un lien ! Plus exactement, un lien sur l'article lui-
même. Cela a été généré en éditant la vue HTML, où le titre est codé comme :   

<a href="{$x.link$}">{$x.headline$}</a> 

CityDesk remplace {$x.link$} avec l'URL actuelle de l'article au moment de la publication. 

{$setDateTimeFormat "French" "dddd d MMMM yyyy" "hh:mm"$} 
Cela fixe le format que CityDesk utilisera pour publier les dates. Pourquoi s'en soucier ? Parce 
que nous voulons imprimer une date au format long : 

{$x.fileddate$} 
Ah oui, cette commande édite la date à laquelle le fichier a été classé. 
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{$x.teaser$} 
Cela affiche le champ "teaser" de l'article : un petit message de texte court sur la page 
d'accueil qui invite le lecteur à lire l'article . 

{$next$} 

Et voilà la fin de notre boucle. S'il reste encore d'autres articles que nous n'avons pas 
imprimés, CityDesk revient au début de l’énoncé foreach et poursuit à nouveau son cycle de 
traitement, assignant cette fois x  vers un article différent. Une fois que nous avons 
terminé de lister tous les articles, CityDesk interrompra la boucle. 

  Fermez la fenêtre index.html.
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Leçon 6 - Modifier une Variable 

Les Variables, qui sont des éléments de CityScript, peuvent être utilisées dans les articles ou 
dans les gabarits de mise en page pour représenter des morceaux de texte que vous avez 
besoin d'utiliser plus d'une fois sur votre site. Quand CityDesk publie un site il remplace 
toutes les variables avec le texte extrait. 

Supposons que vous ayez un patron instable mentalement qui vous demande de créer un site 
Web louant les talents de l'équipe du "PSG ". Depuis que vous savez qu'il est mentalement 
instable, au lieu d'écrire : 

Le PSG  domine la Terre 

vous définissez une variable HumeurDuJour qui peut être définie comme PSG. 
Maintenant vous pouvez écrire  : 

Le {$.HumeurDuJour$} domine la Terre 

et 

Tout le monde acclame {$.HumeurDuJour$} ! 

Comme vous pouvez le constater, pour utiliser le nom de variable, nous l'entourons de {$. 
(notez le point) et de $} (pas de point). 

Maintenant, la semaine prochaine, quand votre patron psycho-instable vous demande de 
changer le site pour encourager, mettons, l'équipe de Monaco, vous n'avez plus qu'à 
modifier la valeur de la variable HumeurduJour  à un endroit et CityDesk se charge du 
reste. 

Dans les réglages par défaut, le gabarit Simple de Mise en Page (template) a une 
variable SiteName utilisée pour le titre en haut de chaque page. Pour modifier le texte à 
l'intérieur, changez juste la valeur de la variable. 

  Dans la fenêtre principale, sélectionnez View Variables ou cliquez sur l'outil Variables 

dans la barre d'outils.          

Vous verrez apparaître une liste de chacun des noms de variables et le texte qu'elles 
représentent. 

  Double-cliquez sur la variable appelée SiteName et donnez-lui une autre valeur. Donnez à 
votre site un nom qui reflète votre personnalité et votre créativité, comme "Bienvenue sur le 
site Web personnel de Jean" (en supposant que vous vous prénommiez Jean bien sûr). 

A chaque fois que CityDesk détectera quelque chose qui ressemble à : 

{$ .SiteName $} 

il le remplacera avec le texte que vous venez juste de taper. 

  Prévisualisez votre site et constatez comment le titre change sur chacune des pages. 
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Leçon 7 - Publier sur un Serveur FTP 

Votre site Web ne vaut pas grand chose si personne ne le voit ! Pour les gens qui le voient, il 
doit être sur un serveur Web quelque part. La commande Publish utilise le protocole 
Internet FTP pour copier tous les fichiers finaux sur un serveur Web. (En option, il peut aussi 
copier le site dans un autre dossier, en copiant simplement les fichiers dans une destination 
que vous choisissez.) 
  Cliquez sur l'outil de Publication dans la barre d'outils ou sélectionnez File » Publish.  

 
Cela vous emmènera à la Fenêtre de Publication. Si c'est la première fois que vous publiez sur 
un serveur FTP, vous avez besoin de dire à CityDesk où vous voulez publier le site. A partir de 
la Fenêtre de Publication : 

  Cliquez sur le bouton  Edit Locations...  (vous devez être en  "Mode Designer" pour voir 
ce bouton). 

  Cliquez sur le bouton Add 

  Réglez les options (à travers un menu "magique") : 

  Pour la méthode, choisissez FTP (vous pouvez aussi publier en copiant simplement  
les fichiers vers un dossier, localement ou sur le réseau) 
  Entrez l'information serveur (nom du serveur "server name", nom d'utilisateur  

"username", mot de passe "password", sous-répertoire "subdirectory", et l'URL) pour 
votre serveur Web.* 
  Pour la Famille de Masques cliquez sur Next. 
  Pour Sélectionner la Langue cliquez sur Next. 
  Pour sélectionner vos Audiences-Cibles cliquez sur Next. Masque, Langue et 

Audience-Cible sont les options les plus avancées décrites ailleurs dans la 
documentation. 
  Fermez la fenêtre Publish Locations. 

Vous pouvez créer autant d'emplacements de publications que vous voulez avec des noms 
différents. Par exemple, si vous avez un serveur Web en France et un autre aux Etats-Unis, 
vous pouvez régler un lieu de publication différent pour chacun d'eux. Ou, par exemple, vous 
pourriez régler deux lieux de publication différents si vous gérez un serveur Web interne 
pour les tests et un serveur Web externe pour le site Web finalisé. 

  Dans la fenêtre principale Publish, choisissez l'emplacement de publication que vous 
venez juste de créer comme « adsf »  et cliquez sur le bouton Publish. 

CityDesk générera les fichiers HTML et les transférera vers le serveur. 

Maintenant que vous avez presque fini de tout régler, à l'avenir vous pouvez publier vers ce 
serveur FTP en cliquant simplement sur l'outil de publication.  
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Leçon 8 - Editer à partir du Navigateur Web 

La loi de Murphy exige que tous les sites Web doivent contenir des fautes de frappes 
gênantes (comme appeler le PDG de votre société "Monsieur Tête de Patate" au lieu de 
l'appeler par son vrai nom). Si vous regardez votre propre site Web sur le Web, c'est agréable 
de réparer ces erreurs à l'instant où vous les constatez. 

La première fois que vous avez fait tourner CityDesk, il a installé une icône dans la barre 
d'outils d'Internet Explorer qui vous laisse éditer les pages que vous avez créées avec 
CityDesk. Quand vous cliquez sur l'icône, une nouvelle copie de CityDesk démarre et vous 
emmène directement à l'article que vous étiez en train de consulter. 

 
 

Pour utiliser cette fonction afin d'éditer un fichier, vous avez besoin d'être sur l'ordinateur qui 
a le fichier original CityDesk 

  Utilisez le bouton de prévisualisation Preview pour prévisualiser votre site. Cliquez sur le 
bouton Internet Explorer pour le voir dans Internet Explorer. 

  Dans Internet Explorer, cliquez sur le lien de l'article Getting Started. 

  Cliquez sur la flèche bas à droite sur le bouton de Modification dans la barre d'outil Internet 
Explorer. Choisissez Edit with CityDesk dans la liste. 

Une autre copie de CityDesk se lancera et vous emmènera directement à l'article Getting 
Started, que vous pouvez aisément modifier, sauvegarder et publier à nouveau. 

Note: si vous ne voyez pas le bouton Modifier avec CityDesk dans Internet Explorer, vous 
devez personnaliser votre barre d'outils. Voilà comment : 

  Dans Internet Explorer, faites un clic-droit sur la barre d'outils principale (c'est celle qui 
contient Arrière, Avant,etc...) 

  Cliquez sur Personnaliser 

  Trouvez le bouton Edition  sur la liste à main gauche et cliquez sur Ajouter 

  Cliquez sur Fermer.
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Leçon 9 - Faire des Sauvegardes de Votre Site 
Généralement, quand vous faites un changement dans CityDesk, il est définitif. Ainsi vous 
devriez toujours faire des sauvegardes fréquentes de votre site. 

Parce que CityDesk stocke tout dans un gros fichier, faire une sauvegarde de votre site est très 
simple : vous n'avez qu'à sortir de CityDesk et copier le fichier dans un endroit sûr. 

Souvenez-vous : Ce n'est pas suffisant de sauvegarder les fichiers sur le serveur Web quand 
vous publiez votre site. Cela vous permettra seulement de retrouver l'édition finale de votre 
site en format HTML, pas la base de données CityDesk qui l'a générée. 

Bien, voilà la fin de l'auto-apprentissage. Vous en savez assez sur CityDesk pour devenir 
dangereux. Pour toute autre information, nous avons une documentation complète. A vous 
de jouer. Bon vent ! 

  Documentation EnL igne Complète  

 

 


